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 عناصرتفعيل التعميم الالكترونى فى نظام تدارس بجامعة الإمام تطبيقا عمى مقرر تحرير 
 الاعلان المرئى وتصميمو لطلاب كمبة الاعلام والاتصال

Activation of E-learning in the system of study at the University of Imam 

applied to the decision to edit elements of the visual declaration and design 

for students of the College of Media and Communication 
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 مصر( –اكتوبر  6)مدرس كمية الفنون التطبيقية جامعة 

 العربية السعودية( المممكة –جامعة الإمام محمد بن سعود الإسلامية الرياض  -)أستاذ مساعد كمية الإعلام والاتصال 
 

 ممخص البحث بالعربية:
يعتبر التعميـ الإلكترونى ىو أحدث أنواع التعمـ التى ظيرت فى مجاؿ التعميـ الذى تدعمو التكنولوجيا، وىو يتوافؽ مع 

عمة ، حيث مف الروافد الأساسية الدا  2030الاحتياجات الإجتماعية ، ومتطمبات تحقيؽ رؤية المممكة العربية السعودية 
لمنظومة التعمـ المتكاممة في المجتمعات العصرية، وذلؾ تمبية للبحتياجات الآنية والمستقبمية ودفع عجمة التنمية الشاممة 
نحو مجتمع المعرفة ؛ و يساىـ نظاـ التعمـ الإلكتروني في صناعة المعرفة وفتح مجالات واسعة لمتعمـ الذاتي المرف 

والخبرات التربوية بطريقة حديثة في بيئة تعميمية تفاعمية غنية بمصادر التعمـ .   والمستمر وتسييؿ انسياب المعمومات
ويأتي الاتجاه العالمي اليوـ نحو التعمـ الإلكتروني مواكبا لمتطورات السريعة والمتلبحقة في المجاؿ التقني، إيمانا بأىميتو 

ـ ويرتقي بالعممية التعميمية إلى مستويات التنافس وفؽ وللبستفادة مف مزاياه وتطبيقاتو المتنوعة بما يحقؽ أىداؼ التعم
 معايير الجودة لموصوؿ إلى مخرجات تعميمية مؤىمة لمعالـ الرقمي في التخصصات العممية المختمفة. 

ويعرض الباحث النقمة النوعية التي يؤدييا التعمـ الإلكتروني، في عممية تدريس عناصر الاعلبف المرئي وتصميمو لطلبب 
ت الإعلبـ والاتصاؿ والتصميـ؛ حيث يوضح الباحث الروافد المتعددة لمقرر عناصر الاعلبف المرئي وتصميمو، في كميا

 مجاؿ الإعلبـ والاتصاؿ، ومنيا: 

 التقنية أو الطريقة الفنية التي يعالج بيا العنصر في التصميـ لإعطاء تأثير معيف. -1
 تج عف التطبيؽ الناجح لمطريقة المستخدمة وتقييـ مدى نجاح التصميـ.المغة التي تصؼ وتحمؿ التأثير البصري النا -2

 ، ومنيا أيضا: الخط، الفراغ، الشكؿ المسطح، والشكؿ المجسـ، الضوء، الموف، المممس، الزخارؼ.

ية ثـ توجو الباحث إلى الاستفادة مف مميزات التعمـ الإلكتروني؛ حيث يتـ تجييز مقرر عناصر التصميـ المرئي )كم   
جامعة الاماـ محمد بف سعود الإسلبمية(، لعرضيا مف خلبؿ منظومة التعمـ الإلكتروني بجامعة  -الإعلبـ والاتصاؿ 

 الإماـ والتى تستخدـ نظاـ تدارس لإدارة التعميـ الإلكترونى، وفييا يتـ عرض نظاـ تدارس وخصائصو ومكوناتو.    

لكتروني لتدريس وحدة عناصر تصميـ الإعلبف المرئي، وذلؾ مف خلبؿ ويقدـ الباحث تطبيقا عمميا لاستخداـ التعمـ الإ
عممية اعداد المادة العممية لعناصر تصميـ الاعلئف المرئى، لعرضيا مف خلبؿ التعميـ دراسة أحد البرامج الأساسية فى 

 "  Macromedia Dream weaver MXكتروني " لالا
 ثـ يعرض الباحث النتائج والتوصيات والمراجع.
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Abstract: 
E-Learning is the latest type of learning that has emerged in technology-supported education 

and is in line with the social needs and requirements of realizing the vision of Saudi Arabia 

2030. It is one of the main tributaries of the integrated learning system in modern societies to 

meet the immediate and future needs of development. The e-learning system contributes to 

the knowledge industry, opens up broad areas of flexible and continuous self-learning, and 

facilitates the flow of information and educational experiences in a modern, interactive and 

rich learning environment. No. The global trend towards e-learning is in line with the rapid 

and progressive developments in the field of technology, in the belief in its importance and 

benefiting from its various advantages and applications to achieve the learning objectives and 

elevates the educational process to levels of competition according to quality standards to 

reach qualified educational outputs in the various scientific disciplines. 

The researcher presents the qualitative shift that e-learning plays in the process of teaching 

the elements of visual advertising and its design to the students of the faculties of media, 

communication and design. The researcher explains the multiple approaches to the decision 

and design of the visual elements in the field of media and communication.  

- -Technical or technical method in which the element is treated in design to give a certain 

effect. 

2 . - Language that describes and analyzes the visual effect of the successful application of the 

method used and the evaluation of the design success. 

 ,Including: font, space, flat shape, hologram, light, color, texture, ornamentation,. 

he course aims to benefit from the advantages of e-learning. The course is designed to be 

presented through the e-learning system at Al-Imam University, which uses an e-learning 

system. Study, characteristics and components. 

The researcher offers a practical application to use e-learning to teach the elements of visual 

design elements by studying one of the basic programs in the process of preparing the 

scientific material for the design elements of the visual media, to be presented through e-

learning "Macromedia Dream weaver MX" 

The researcher then presents the results, recommendations and references. 

 -مشكمة البحث: 
ما ىى الدوافع والعوامؿ التى تظير تفعيؿ التعميـ الالكترونى فى عممية تدريس مقرر عناصر تصميـ الاعلبف  -

 المرئى؟
ما ىى مميزات التعميـ الالكترونى التى ترتقي بالعممية التعميمية، فى المممكة العربية السعودية إلى مستويات تنافسية  -

 ؟2030تحقيقا لرؤية 
 ى مدى تعتبر البحوث فى التعميـ الالكترونى فى البلبد العربية والاسلبمية كافية لتطوير التعميـ الجامعى؟الى ا -
 ما ىو نظاـ تدارس بجامعة الاماـ محمد بف سعود الاسلبمية؟ -

 - ىدف البحث:
علبف المرئي، وتفعيؿ الاستفادة مف التعمـ الإلكتروني في كمية الإعلبـ والإتصاؿ تطبيقًا عمى مقرر عناصر تصميـ الإ -

مزاياه وتطبيقاتو المتنوعة بما يرتقي بالعممية التعميمية، فى المممكة العربية السعودية إلى مستويات تنافسية تحقيقا لرؤية 
لممممكة العربية السعودية، ووفؽ معايير الجودة لموصوؿ إلى مخرجات تعميمية مؤىمة لمعالـ الرقمي في مجاؿ  2030

 ؿ.الإعلبـ والاتصا
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إيضاح الدوافع لاستخداـ تطبيقات الإنترنت والانترانت والاكسترانت، في عممية تدريس مقرر عناصر تصميـ الإعلبف  -
 المرئي. 

 تفعيؿ نظاـ تدارس بجامعة الإماـ محمد بف سعود الإسلبمية، مف خلبؿ مقرر عناصر تضميـ الإعلبف المرئى. -
 -أىمية البحث: 

لمقرر عناصر تصميـ الإعلبف المرئى لعرضيا مف خلبؿ التعمـ الإلكتروني، ودورىا في  يساىـ في إعداد المادة العممية -
خمؽ بيئة تعميمية تفاعمية يجيد فييا كؿ مف أستاذ تصميـ الإعلبف المرئي، والطلبب بكمية الإعلبـ والاتصاؿ، كيفية 

 التعامؿ مع محتوى المادة العممية والتفاعؿ مع الآخريف.
تطوير التعميـ في البلبد العربية بتطبيؽ التعمـ الإلكتروني، لما سيضفيو عمى المجتمعات العربية تسريع خطوات عممية  -

 مف ارتقاء في المستوى التعميمي والثقافي.
 -فروض البحث: 

تحويؿ وحدة عناصر تصميـ الإعلبف المرئى في مقرر تحرير الإعلبف المرئى وتصميمو لمقرر تعمـ إلكتروني عمى  -
 في مجاؿ الإعلبـ والاتصاؿ. حقؽ إضافة كمية ونوعية في عممية تدريسو،نظاـ تدارس ي

  -حدود البحث :
تييئة المادة العممية مف مقرر عناصر تصميـ الإعلبف المرئى، في كمية الإعلبـ والاتصاؿ لعرضيا عمى الموقع 

ة مف خلبؿ دراسة أحد البرامج الأساسية وتتـ ىذه العممي الإلكتروني لنظاـ تدارس بجامعة الإماـ محمد بف سعود الإسلبمية،
 Macromedia" كتروني لالاعممية اعداد المادة العممية لعناصر تصميـ الاعلئف المرئى، لعرضيا مف خلبؿ التعميـ فى 

Dream weaver MX :   ،يتـ تدريس مقرر عناصر تصميـ الاعلبف المرئى فى قسـ الاذاعة والتميمفزيوف والفيمـ (
 كمية الاعلبـ والاتصاؿ ( –الاعلبف والاتصاؿ التسويقى وكذلؾ فى قسـ 

 -منيجية البحث:  -
 المنيج التحميمى مع استخداـ التطبيؽ العممي. -

 مقرر تحرير عناصر الاعلان المرئى: 
يتـ تدريس مقرر عناصر تصميـ الاعلبف المرئى فى قسـ الاذاعة والتميمفزيوف والفيمـ، وكذلؾ فى قسـ الاعلبف والاتصاؿ 

كمية الاعلبـ والاتصاؿ جامعة الاماـ ، حيث يتعرؼ الطلبب عمى المعارؼ الاساسية والنظرية عف تحرير  –تسويقى ال
وتصميـ الاعلبف التميفزيونى ، عناصر تصميـ الاعلبف التميفزيونى واخراجو ، عناصر تصميـ الاعلبف فى الانترنت 

لبنى ، اسس كتابة وتحرير الاعلبف التميفزيونى وفى الانترنت واخراجو ،الاتجاىات الحديثة فى التصميـ والاخراج الاع
 ،العلبقة بيف تحرير وتصميـ الاعلبف وبيف نظريات الاقناع ، خطوات بناء الاعلبف التميفزيونى .

 عناصر التصميم
 عناصر التصميـ ىي مفردات لغة الشكؿ التي يستخدميا المصمـ، وسميت بعناصر التصميـ أو التشكيؿ نسبة إلى
إمكانياتيا المرنة في اتخاذ أي ىيئة مرنة وقابميتيا للبندماج والتآلؼ والتوحد بعضيا مع بعض لتكوف شكلًب كميا لمعمؿ 

ونعني بعناصر التصميـ كؿ ما يمكف رؤيتو في العمؿ الفني أو ىي أصغر العناصر القابمة لمتكرار  الفني أو التصميـ.
يحقؽ غرض، ويصعب رؤيتيا منفصمة، ويمكف فصميا لمدراسة والتعرؼ عمى والتجاور والتبادؿ والتصفيؼ لتكوف كلًب 

القوي الكامنة بيا وما يمكف أف نحققو في العمؿ الفني، ومف ىذه العناصر ما يمكف تجميعو لتكويف عناصر أخري أكبر، 



 العدد العاشر                                                                           ة العمارة والفنوف           مجم

  208 

يزداد الإبصار الجمالي  ومنيا ما يمكف أف يطمؽ عميو أكثر مف مسمي. وبتوافر ىذه العناصر في العمؿ الفني بقدر معيف،
 حدة وتزداد التجربة الجمالية إمتاعاً. 

فعند بناء أي تصميـ مف الضروري التفكير في كؿ عنصر مف العناصر المكونة لو عمى حده حتى يمكف أف يتلبءـ داخؿ 
ر داخؿ التصميـ الوحدة مع باقي العناصر فلب يشذ أحدىما عف الآخر، بؿ لابد أف يكوف ىناؾ ترابط وتناسؽ بيف العناص
حيث أف جماؿ  حتى نصؿ إلى الصورة الفنية المرجوة فمثلًب الشكؿ لا يتواجد بدوف الخط والفراغ، الموف يتوقؼ عمى الضوء

 كؿ عنصر يتوقؼ عمى الصمة بينو وبيف العناصر الأخرى حتى نصؿ إلى الصورة الفنية المبتكرة. 
 وتتكوف عناصر التصميـ في الملببس مف: 

الشكؿ المسطح والشكؿ المجسـ.                     -3الفراغ.              -2      الخط.    -1
 الضوء.              -4
 الزخارؼ. -7المممس.          -6الموف.               - 5

ى وسيتـ عرض كؿ مف عنصري الخط والفراغ أولًا لإعطاء خمفية لمشكؿ المسطح والمجسـ الذي يمييما، ثـ نتعرؼ عم
" حيث أف كؿ تمؾ العناصر تؤثر Patternثـ أخيراً نذكر الزخارؼ " الضوء الذي ينعكس أثره عمى الموف والمممس.

 وتشارؾ فيو فيو لا يعد عنصر مفرد ولكنو تنظيـ لمجموعة العناصر في أو عمى السطح. 

 "Lineالخط "
 تعريفو: 

يا كما إنو أيضاً يعتبر مف أكثر العناصر تعقيداً إذا لـ الخط مف أىـ العناصر التي يستخدميا المصمـ في عممو وأبسط
 يستخدـ بحكمة فالخطوط المختمفة ىي التي تحدد الشكؿ العاـ. 

 
 *مظاىر الخط: 

 (1مف الممكف تحميؿ الخط إلى مظاىره الثمانية كالآتي : كما في جدوؿ )
 "Continuityالاستمرارية "-Thickness        "3السمؾ "- Path      "2المسار "-1
الكثافة أو القواـ )التماسؾ( -Contour of edge    "6شكؿ الحافة "-Sharpness of edge    "5حدة الحافة "-4
"Consistency        "7-" الطوؿLength                "8 -" الاتجاهDirection" 

  تنقسـ الخطوط إلى:أنواع الخطوط:   
 خطوط منحنية -الخطوط المائمة-الخطوط الأفقية ج-ب سيةالخطوط الرأ-: أخطوط مستقيمة وتشمؿ

 
 ( تحميؿ مظاىر الخط الثمانية 1جدوؿ )

 الخاصية الاختلبفات المظير التأثيرات المادية التأثيرات النفسية
الإحساس بالصلببة، المباشرة، 
القوة، الدقة، الاعتزاز، التأكيد، 
عدـ القابمية للبنثناء، الجدة، 

 الرجولة.

يد عمى زوايا التأك
الجسـ عدا 
 الاستدارات

 
 أ.الاستقامة
Straight 

(المسار 1)
path 

الإحساس بالنعومة، الرقة،  يؤكد قميلب عمى  ب.الانحناء    
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 الخاصية الاختلبفات المظير التأثيرات المادية التأثيرات النفسية
المرونة الجاذبية، الإحساس 

بالأنثوية ػ التدفؽ بصفة عامة 
يعطي إحساس أكثر جاذبية 
خاصة إذا كاف غير منظـ 

 قميلب. 

منحنيات الجسـ 
 برقة.

مشدود ال
Restrained 

curve  

متحرؾ، أنثوي، غير مشدود، 
شبابي، نشيط، عنيؼ، غير 

 ثابت، بييج.

يؤكد عمى 
 منحنيات الجسـ.

 
 ج. المنحني التاـ 

Full curve  
 

 

ىذا النوع ىو والمنحني المشدود 
ىي الخطوط الأكثر وجوداً في 
الطبيعة في الأنيار، الأشجار، 

التلبؿ، ويمكف أف تعطي 
حساس بكؿ مف العنؼ والرقة الإ

 تبعاً لطريقة استخداميا.

يجمع بيف التأثيرات 
المستقيمة 
 والمنحنية.

  Bentد. الانثناء  

إحساس مفاجئ، عصبي، غير 
ثابت متصؿ الحركة، مثير، 

 متقمب، منقبض.

 يؤكد عمى الزوايا. 
 

ىػ. التعرج 
)الانبعاجات( 

Jagged  

 

لولبي نشيط، ناعـ، أنثوي، 
 غير مؤكد.خفيؼ 

تؤكد عمى 
 الاستدارة.

 
و. المولبية 
Looped  

 

إحساس أنثوي، ناعـ، متدفؽ، 
جذاب، حساس، مرف، غير 

 مؤكد، يتحرؾ لأعمي.

يؤكد عمى 
الاستدارة ضد 

 الزاوية.

 
ز. التموج )الشكؿ 

 wavyالموجي( 
 

احساس أنثوي، ناعـ، متدفؽ، 
جذاب،حساس، مرف،غير 

 مؤكد، يتحرؾ لأعمى ولأسفؿ. 

تكرار الاستدارة 
 ضد الزوايا. 

 
ح. الفوسطونات 

Scalloped  
)سمسمة نتؤاءت 

 مستديرة(

 

إحساس حاد، متصؿ الحركة، 
منتظـ، رجولي، متقمب، 
 مفاجئ، مكثؼ، صمب. 

يؤكد عمى الزاوية 
 وضد الاستدارة.

 
ط. الزجزاج 

Zigzag 
 

إحساس بالارتباط، معقد، 
 خشف.

 حدود خشنة .
 

ى. التجعد 
Crimped  

 

إحساس بالقوة، العنؼ، التأكيد، 
 الرجولية، الثقة.

 يضيؼ وزنا.
 

 ( السمؾ 2) Thickأ.السميؾ 
Thick-
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 الخاصية الاختلبفات المظير التأثيرات المادية التأثيرات النفسية
ness 

 يقمؿ الوزف . رقيؽ،أنثوي، ىادئ .
 

  Thinب. الرفيع 
غير ثابت، غير مؤكد، مترنح، 

 غير أمف، متسائؿ .
 انتفاخات مفاجئة 

 
الغير مستوي  -ج

Uneven       
 

ناعـ، آمف، مؤكد  منتظـ،
 ثابت.

الانتظاـ، الثبات 
 الطبيعي .

 
د. المستوي ) 
المنظـ( منتظـ 

 Evenالاستواء 

 

يعطي إحساس مؤكد ػ متدفؽ، 
 ثابت راقي، ناعـ، واضح. 

ناعـ يقوي الخطوط 
 الناعمة.

 
أ. مستمرة غير 

 منقطع 
Continuous 

unbroken 

(3 )
 الاستمرارية

Con-
tinuiy     

دا، مقطوع، أقؿ تأكي   
منفصؿ،رياضي شبابي، ممئ 

 بالمعب. 

قد يؤكد عدـ 
 الانتظامية .

 
 ب. متقطع 

Broken 

ىو أيضاً أقؿ توكيدا، منفصؿ، 
مقطوع، شبابي، ممئ بالمعب، 
 مبدى للبقتراحات والأفكار. 

قد يكوف بو نقط 
ليا مساحات أو 

 متنوع. 

 
 ج. المنقط 
Dotted  

توجو إلى اتصاؿ الحركة 
ذا ما استخدمت المت قطعة وا 

بكثرة فإنيا يمكف أف تعطي 
رتابة زخرفية وىي بشكؿ عاـ 

 " .    Casualغير رسمية " 
          

 متنوع .
 

د.التكوينات 
 المتآلفة

Combinations  

 
 
 
 
 
 

تأثير واضح دقيؽ، مؤكد، 
 واثؽ، صمب، قوي، مباشر. 

تؤكد المنطقة سواء 
 ممساء أو منبعجة.

 
( حدة 4)  Sharpأ. حادة 

 الحافة
Edge 

sharp-
ness  

إحساس ناعـ، غير مؤكد، غير 
 واضح، يقترح أفكار عديدة.

يزيد المساحة قميلًب 
 وينعـ .

 
ب. مزغب/ 

 Fuzzyمشوش 

ناعـ، بسيط، مستقيـ للؤماـ 
مؤكد النعومة مع اختفاء 

 العيوب. 

يقوي الأحساس 
بالنعومة او يؤكد 

 الانبعاج .

 
( شكؿ 5)  Smoothأ. ناعـ 

 الحافة
Edge 
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 الخاصية الاختلبفات المظير التأثيرات المادية التأثيرات النفسية
إحساس معقد، مرتبط،متصؿ 
الحركة، متحرؾ، غير تقميدي، 

 غير مباشر، ممتع. 

يختمؼ تبعاً لنوع 
 الشكؿ. 

 
ب. لو شكؿ 
Shaped  

contour 

 . يتقدـ للؤماـ  ناعـ، واثؽ، قوي، صارـ
 بجراءة. 

 
مصمت،  -أ

مغمؽ، ناعـ 
Solid, Closed, 

Smooth,  

(6 )
التماسؾ        

القواـ()
Con-     

  
sistency 

     

إحساس بالرقة، الضعؼ، وأقؿ 
 تأكيد.

يتقدـ قميلًب ثـ 
 يتراجع او يتقيقر.

 
مسامي مفرغ    -ب

Porous 

ينظر إليو عادة  طوؿ الخط،
بالنسبة لخطوط أخرى أو 
مسافة. فالخط الطويؿ في 

قطعة ملببس عموية )بموزة( قد 
يكوف قصيراً بالنسبة لجونمة أو 

ستاف وىو يعطي استمرارية، ف
 نعومة، تدفؽ جذاب.

يؤكد اتجاىو يزيد 
مف الطوؿ 

 الحقيقي، ينعـ.

 
( الطوؿ 7) Longأ. الطويؿ 

Length  

الخط الذي ينظر إليو عمى أنو 
قصير بالنسبة للآخريف يميؿ 
إلى أف يعطي تأثيراً منفصلًب 
 ومفاجئاً وقوياً بشكؿ أكثر. 

يقسـ المسافات،و 
اس يزيد الإحس
 بالامتلبء.

 
ب. القصير 

Short  

يعطي احساس بالعزة والقوة 
والثبات الصلببة واليقظة 
 الانضباط والجماؿ والثقة.

يزيد في الطوؿ، 
 يقمؿ العرض.

 
 أ. الرأسي 
Vertical  

 ( الاتجاه8)
Direc- 

tion 
إحساس باليدوء، الارتياح،   

 السلبـ.
يقمؿ الطوؿ، يزيد 

 العرض

 
 ب. الأفقي

Horizontal  
الشعور بالنشاط والحركة وعدـ 

 الثبات.
الأقرب إلى  -

 الرأسي يزيد الطوؿ 
الأقرب إلى  -

الأفقي يزيد العرض. 
يعتمد  454بزاوية  -

الأثر ىنا عمى 
التصميمات 
 المحيطة.

 
 ج.المائؿ 

Diagonal  
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 "Spaceالفراغ " -2
 *تعريفو: 

 حجـ ، ويتـ تصنيؼ الفراغ تبعاً لتعاممنا معو في التصميـ إلى نوعيف: الفراغ ىو حيز أو مساحة أما مسطحة أو ذات 
 الأوؿ: ىو الفراغ الذي يتواجد في التصميـ المسطح. 

 الثاني: ىو الفراغ الحقيقي الذي يلبزـ تواجد العناصر المجسمة. 
فاعمياتو تبعاً لكيفيات توظيؼ والفراغ في التصميمات المسطحة يطمؽ عمييا اصطلبحياً لفظ "الأرضية" وتتبايف مظاىره و 

الأشكاؿ فيبدو أحياناً كأرضية مسطحة تحيط بالأشكاؿ وأحياناً أخرى يبدو كفراغات تحتوييا الأشكاؿ بطرؽ مختمفة تتوقؼ 
عمى كيفياتيا البنائية. كما يتبايف الإحساس بالعمؽ أيضاً نتيجة لاستخداـ عناصر شكمية مسطحة أو مجسمة تجسيماً 

 ي إلى إدراؾ العمؽ المنظوري إدراكاً تقديرياً.تقديرياً يؤد
أما الفراغ الحقيقي فمرتبط بطبيعة المكاف، ويؤثر في فاعميات الحجوـ التي تتواجد فيو وفي العلبقة بينيا كما أنو يتأثر  

مثمو للؤشكاؿ بطريقة بناء الحجوـ المختمفة ويتنوع أيضاً بيف فراغات تحيط بالأجساـ أو تتخمميا أو تنفذ منيا. ونجد أ
ومف آراء ىربت ريد عف الفراغ "لابد أف يفكر الفناف في حجـ الأشكاؿ في الفراغ وفي  .الثلبثية الأبعاد المحاطة بالفراغ

الضوء وفي الظؿ في ارتباط وثيؽ ببعضيا البعض فيي جميعاً جوانب مف إحساس الفناف بالفراغ، فالكتمة فراغ صمب 
 ة بالنسبة لمفراغ وليس الفراغ الاعكس الكتمة".والظؿ والضوء ىو تأثيرات الكتم

" بينما  Positive space" أو الفراغ الإيجابي "  Shape" عادة بالشكؿ "Enclosed spaceويسمى الفراغ المحصور "
". إف Negative space" أو الفراغ السمبي "Space" بالفراغ "Unenclosed spaceيسمى الفراغ غير المحصور "

مغمقة أو "الأشكاؿ" عادة ما تمثؿ أشياء ترتبط لدينا بمعاني مثؿ الزىرة أو الكورة أو غيرىا، وىذا الارتباط يجذب الفراغات ال
الانتباه إلييا بينما يتـ نسياف تمؾ الفراغات التي تحيط بيذه الأشكاؿ وتفصؿ بينيا. ولإدراؾ أىمية الفراغ لابد مف التعرؼ 

 فراغ ىما: عمى مجموعتيف رئيسيتيف مف خصائص ال
 أولًا: عوامؿ تؤثر في إدراؾ العلبقة بيف الشكؿ والفراغ.

 ثانياً: عوامؿ تؤثر في الوضع الظاىري )المرئي( لمشكؿ والفراغ. 
 عوامل تؤثر في إدراك العلاقة بين الشكل والفراغ: اولا:
 كثافة الأجزاء الفراغية.-2حجـ الأجزاء الفراغية.             -1
  الضغط.-4              قعرات.التحدبات والت-3
 حجم الأجزاء الفراغية:  -1

 .إف المساحات الصغيرة تميؿ لأف تبدو أشكالًا أما المساحات الكبيرة تميؿ لأف تبدو فراغات 
 كثافة الأجزاء الفراغية:  -2

الممساء وبالتالي في حالة  إف المساحات المزخرفة أو ذات التأثيرات المممسية ليا تأثير مرئي أقوي مف المساحات الخالية
وجود مساحة مزخرفة أو ذات تأثير مممسى مرئي عمى مساحة ممساء خالية فإف المساحة الأولى سوؼ تفرض نفسيا 

ولكف إذا أنعكس الوضع وأصبحت المساحة المحيطة بالشكؿ ذات  ،كشكؿ في حيف أف الأخرى تظؿ كفراغ أو كأرضية ليا
 خشف. بإطار ذو مممس صبح كفجوة فراغية محاطةمممس فإننا سوؼ نشعر أف الشكؿ أ

 التحدب والتقعر: -3
" كفراغات محصورة أي كأشكاؿ ، بينما تبدو المساحات Convexitiesتبدو المساحات أو المناطؽ المحدبة لمخارج "

  " كفراغات.Concavitiesالمقعرة لمداخؿ"
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 الضغط )التعادل بين الشكل الإيجابي والفراغ السمبي(:-4
تحدثنا عف الشكؿ باعتباره مساحة محدبة تدفع لمخارج أي ليا ضغط داخمي متجاىميف بذلؾ الفراغ بعدـ اعتباره ضاغط  لقد

أيضاً عمى الشكؿ مف الخارج. فالضغط عامؿ ميـ في الحياة فإف التفاحة الموضوعة داخؿ فراغ سوؼ تنفجر مف الضغط 
اغ ليس مجرد مساحة مجيولة تحيط بالشكؿ ولكنو عضو نشط في الداخمي إذا لـ يوجد ضغط يقابمو مف الخارج. فالفر 

 العلبقة الديناميكية. 
 

 ثانياً: عوامل تؤثر في الوضع الظاىري "المرئي" لمشكل والفراغ:
 الشكل كشكل أمامي ، والفراغ كخمفية: 

ف أف نعتبرىا دلالات ىناؾ عدة ظواىر مرئية في التصميمات تؤثر عمى مساحة ما مف حيث كونيا الشكؿ والأرضية يمك
لمعمؽ الفراغى. ويستخدـ مصمموا الأزياء تمؾ الظواىر لمحصوؿ عمى تأثيرات مرغوبة أما في التصميـ البنائي أو التصميـ 

 الزخرفي كما نرى: 

 المساحات الصغيرة تدرؾ كأشكاؿ أما مساحات الكبيرة مثؿ الجونمة تدرؾ كمساحات محيطة أو كأرضية أو خمفية ما. -1
عندما يحاط الفراغ الإيجابي "الشكؿ" بالكامؿ بالفراغ السمبي يري الشكؿ وكأنو في المقدمة بينما يبدو الفراغ في  -2

 الخمفية.
تراكب الأشكاؿ في الحقؿ المرئي يوحي بأف ىناؾ شكلًب يتقدـ عف الآخر فالشكؿ الكامؿ ىو الذي يبدو في المقدمة أما  -3

 الخمؼ.  الشكؿ الغير كامؿ فيبدو وكأنو في
استخداـ الألواف الباردة والدافئة في التصميـ يوحي بالعمؽ الفراغي، وخاصة إذا وضعت الألواف الباردة في نياية  -4

)لما ليا مف خاصية التراجع( ووضعت الألواف الدافئة في بداية لما ليا مف خاصية التقدـ والانتشار. حيث يٌري  التصميـ
 س بالتقدـ في حيف يظير الموف الأزرؽ البارد متأخراً.الموف الأحمر الدافئ يعطي إحسا

 استخداـ القيـ المونية المتدرجة سواء لموف واحد أو لعدة ألواف في التصميـ يوحي بالعمؽ الفراغي. -5
عندما يكوف الشكؿ محاط بخطوط غير متقطعة فإنيا تعطينا إحساس بأف الشكؿ لو كثافة أكبر ويبدو أنو أقرب بينما -6

يحيط بالشكؿ خطوط متقطعة فإنو يبدو أبعد، وىذا التكنيؾ يمكف أف يكوف مفيداً في خمؽ تأثيرات متعددة في  عندما
 التصميمات المختمفة.

عندما يحيط بالشكؿ خطوط غير متقطعة فإنو يبدو متقدماً وكمما زاد سمؾ الخطوط المحيطة كمما بدا الشكؿ أقرب -7
 . وكمما قؿ سمكيا كمما بدا الشكؿ أبعد

والملبمس المتعددة  استخداـ القيـ السطحية ذات الدرجات المتفاوتة يوحي بتنوع ارتفاعات السطوح نتيجة تعدد ملبمسيا،-8
 في حد ذاتيا توحي بالبعد الثالث. 

 
 "Shape & Formالشكل المسطح والشكل المجسم "  -2

يو يعني الفراغ الحجمي المحاط بأسطح الشكؿ المسطح يعني الفراغ المحاط بخطوط خارجية بينما الشكؿ المجسـ ف
 خارجية. 
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 * الشكل المسطح: 
 -تعريف الشكل المسطح:  -1

ىو أكثر العناصر التشكيمية إمتاعاً وأىمية، وىو الاسـ الذي يطمؽ عمى مجموع الأجزاء، وعلبقتيا ببعضيا البعض، وفي 
قات، والشكؿ المسطح ىو ذلؾ العنصر الذي يعكس التنظيـ والترتيب ومجموع العلب ىذه الحالة يكوف مرادفات الشكؿ ىو

 فيو يحدد الشكؿ العاـ. الأبعاد الخارجية لتمؾ الخطوط المحددة ويتضمف الفراغات والمساحات
 أنواع الشكل المسطح:  -2

 الشكؿ ىو مسطح قد يكوف متساوي الأبعاد أو غير متساوي الأبعاد: 
 بع والدائرة والمثمث متساوي الأضلبع والمخمس والمسدس والمثمف.الأشكاؿ المسطحة متساوية الأبعاد مثؿ المر  -أ
الأشكاؿ المسطحة غير متساوية الأبعاد مثؿ البيضاوى، والمثمث متساوي الضمعيف، والمثمث مختمؼ الأضلبع،  -ب

ة، والدمعة، والمستطيؿ، ومتوازي الأضلبع، والمعيف، وشبو المنحرؼ، وغيره مف اِلأشكاؿ المختمفة كشكؿ القمب، والنجم
والشكؿ الكمثرى وغيره. إف الأشكاؿ المسطحة متساوية الأبعاد عند تجمعيا معاً في شكؿ واحد لا تترؾ مسافات بينية بيف 
وحداتيا مما يعطي تأثيراً بالأماف والثبات والنظامية أما الأشكاؿ غير متساوية الأبعاد عند تجمعيا فإنيا تعطي فراغات بيف 

  جديدة بيا تنوع وتشوؽ يكمؿ الشكؿ العاـ وتكوف أقؿ ثباتاً.وحداتيا تخمؽ أشكالاً 
 
 :تعريف الشكل المجسم -1

يعرؼ الشكؿ المجسـ بأنو شكؿ ذو ثلبث أبعاد نَصِفوُ بعدد الأسطح لو سواء كانت مستوية أو غير مستوية أو بمعني آخر 
يطمؽ عمييا حجـ أما إذا كانت مصمتة  الشكؿ المجسـ ىو مساحة ذات ثلبث أبعاد تحيط بيا أسطح ولو كانت مجوفة

فتوصؼ عمى أنيا كتمة وفي مجاؿ الملببس يعتبر جسـ الانساف كتمو محاطة بحواؼ بما فييا الأجزاء المحدبة 
 والانبعاجات عمى سطح الجمد، وكذلؾ أجزاء الملببس البنائية جميعاً تمثؿ أشكالًا مجوفة تحيط بكتمة الجسـ. 

 أنواع الشكل المجسم: -2
 الشكؿ المجسـ إما أف يكوف ذو أسطح متساوية أو غير متساوية: 

 الحجوـ ذات الأسطح المتساوية مثؿ الكرة والمكعب والمنشور الثلبثي. -أ
، ومتوازي الأضلبع، والناقوس، والقبة،  -ب الحجوـ ذات الأسطح غير المتساوية مثؿ الأسطوانة، والمخروط، واليرـ

 لرممية، والبوؽ.والبيضة، والفانوس، والساعة ا

 
 "Colorالمون " -

الموف ىو أحد العناصر اليامة في التصميـ والأكثر إثارة، فلب يمكف تخيؿ عالـ الأزياء والموضة بدوف الألواف، وعف طريقو 
يمكف التعبير عف أنفسنا وطبيعة مشاعرنا، كما أف حسف اختيار وتآلؼ الألواف في تصميـ الأزياء يمكف أف يصؿ بنا إلى 

عمى درجة عالية مف الجماؿ والانسجاـ والتآلؼ حيث أف كؿ لوف يستخدمو المصمـ يكوف فراغ لو دلالة حسب  زي
مساحتو داخؿ الزي، أو علبقتو بالألواف الأخرى، وعنصر الموف يمثؿ أىـ الجوانب الشخصية في الموضة فمصممو الأزياء 

في كؿ موسـ، ويستخدموف توليفات مف الألواف بحيث تتماشى مع  يرتبطوف في مجموعاتيـ الجديدة للؤزياء بالألواف الجديدة
 بعضيا وتعمؿ عمى نجاح التصميـ . 
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 ويتم تقسيم المون من الناحية العممية إلى فئتين:
 ": وىي ألواف ذات صبغة لونية كألواف الطيؼ.Chromaticأولًا: ألواف كروماتؾ "

ليس ليا صبغة لونية أي لا لوف ليا مثؿ الأبيض والأسود والرمادي  ": وىي ألوافAchromaticثانياً: ألواف أكروماتؾ "
 وتسمي بالحياديات )ليست ألوانا حقيقية(، أما الألواف المركبة فيقاؿ أف ليا صبغة لونية.

 *الخواص المرئية لمون: 
مؿ سوؼ يتبعو تغير " والتغير في أي عامؿ مف ىذه العواIntensity" وشدتو "Value" وقيمتو "Hueيعرؼ الموف بصفتو "
 في خواص الموف. 

 ":Hueصفة أو كنة المون " -1
ىي الخاصية التي تميز الموف عف غيره مف حيث الاسـ والنوع فعندما يطمؽ عمى لوف أحمر أو أزرؽ أو غيره، فإف ىذا 

الموف أو لونيتو أو يعني تحديد كنة ونوع الموف وصفتو وىي تعبر عف الموف النقي غير الممزوج بألواف أخرى، وعف درجة 
 أصؿ الموف. 

 ":Valueقيمة المون" -2
"، وألواف الطيؼ ىي ذات Darkness" أو عتامتو "Lightnessىي الخاصية التي تشير إلى نصاعة الموف "إضاءتو" "

ة أي " غير متساوية القيمة فالأصفر أكثرىا إضاءة و البنفسجي أكثرىا عتامة. وقيمPure Hueقيمة طبيعية لأنيا نقية "
" قد تتغير بإضافة الأسود أو الأبيض أو الرمادي وتغير الموف بإضافة أي مف تمؾ الألواف الثلبث Pure Hueلوف نقي "

" والأبيض ينتج درجات لونية Shadesسوؼ يغير مف شدة الموف )تشبعو( فالأسود عند إضافتو لأي لوف نقي ينتج ظلبؿ "
 ". Tonsلونية متوسطة "" بينما الرمادي ينتج درجات Tentsفاتحة "

 ":Intensityشدة المون " -3
" وىذه المصطمحات تعني مدي نقاء الموف إلى Saturation" أو "Chromaىذه الخاصية تشير إلى كثافة وتشبع الموف "

ربعة درجة التشبع وكمما كاف الموف نقياً كمما كاف أكثر شدة ويمكف تقميؿ شدة الموف أو تشبعو بإضافة أحد الألواف الأ
 -الآتية:

الأسود، أو الرمادي، أو الأبيض، أو الألواف المكممة )الألواف التي عمى الجية المقابمة بدائرة الموف( وبمجرد إضافة أي لوف 
مف ىذه الألواف فإف الموف الأصمي سوؼ ينتقؿ بعيداً عف حالة نقائو وبالتالي يصبح أقؿ في شدتو، فمثلًب الموناف البني 

 الأصؿ ألواف تـ تقميؿ شدتيا بخمط الألواف المتقابمة مف دائرة الموف مع إضافة الأبيض. والبيج ىما في 
كما أف الألواف التي ليا كثافة أكبر مف كثافة لوف الشعر تسمب بعضاً مف لونو، كما تبرز الألواف عالية الكثافة الألواف 

في أي منطقة لونية قريبة فالستاف الأخضر الساطع  المكممة ليا فالموف الأخضر عالي الكثافة يبرز الأحمر المكمؿ لو
 يجعؿ البشرة السمراء تبدو قرمزية. 

 *نظم تنسيق الألوان وقياساتيا:
الموف كظاىرة تناوليا كثير مف الفلبسفة والعمماء والفنانيف بالبحث منذ قروف وكانت أوؿ محاولة عممية ناجحة قاـ بيا 

الأبيض إلى مكوناتو )ألواف الطيؼ السبعة( وقاـ بوصفيا في شكؿ دائرة، ولكف إسحاؽ نيوتف عندما قاـ بتحميؿ الضوء 
وفيو تنظـ  1731المحاولات الجادة لنظـ تنسيؽ الألواف بدأت في القرف الثامف عشر فنجد نظاـ برانج الذي ظير عاـ 
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مط كؿ أثنيف منيما ثلبثة ألواف الألواف عمى شكؿ دائرة تحتوي عمى أثني عشر لوناً وىـ ثلبثة ألواف أساسية، ينتج عف خ
ثـ قاـ عالـ الحشرات "موريس ىاريس" بعمؿ نظاـ لوصؼ  ثانوية، وتخمط الألواف الأولية بالثانوية تنتج ستة ألواف ثلبثية

 . 1776" النظاـ الطبيعي للؤلواف في لندف عاـ Natural System Of Colorالألواف تـ نشره في بحث بعنواف "
" تجميع الألواف المستعممة في الصباغة ووضع نظاماً لقياس الألواف عف طريؽ M.E.Chevreul" حاوؿ 1824وفي عاـ 

 . 1500خمط أثني عشر لوناً أساسياً وحدد عدد الصبغات المستعممة إلى 
 " نظاـ تسميو الألواف وىو يشبو نظاـ النوتة الموسيقية لكيA.H.Munsellأعمف العالـ الأمريكي مانسؿ" 1905وفي عاـ 

يستخدـ في تحديد مواصفات الألواف وقياسيا ومنذ ذلؾ الحيف والدراسات والأبحاث في مجاؿ الألواف أنتجت لنا الكثير مف 
 نظـ التنسيؽ الموني. 

وتنبع أىمية نظـ تنسيؽ الألواف مف الحاجة المتزايدة لوجود اصطلبحات ولغة وطريقة متعارؼ عمييا تسمح بتحديد 
 أصبحت جانباً ىاماً في صناعات الأصباغ والطباعة والنسيج والملببس والديكور والرسـ والزخرفة مواصفات الألواف بعد أف

 ...........إلخ. 

 * الدائرة المونية:
تعتبر الوسيمة العممية لدارسة الألواف ونستطيع عف طريقيا أف نتعمـ منيا كيفية خمط الألواف مع بعضيا، كما تستخدـ في 

 ودائرة الألواف تحتوي عمى اثنا عشر لوناً مقسميف إلى ثلبث مجموعات ىـ:تدريب الطلبب عمييا، 

 الألوان الأساسية )أولية(: -1
ىي: الأحمر والأصفر والأزرؽ، ويطمؽ عمييا ألواناً أساسية لأنيا لا يمكف تكوينيا مف أي ألواف أخري، وتوضع عمى 

 مسافات متساوية مف بعضيا في الدائرة المونية. 

 ن الثانوية:الألوا -2
 وىي: البرتقالي والأخضر والبنفسجيِ، وىي ناتجة عف مزج كمية متساوية مف لونيف أساسييف معاً. 

 الألوان الثلاثية )المشتقة(: -3
وىي: البرتقالي مصفر، برتقالي محمر، بنفسجي محمر، بنفسجي مزرؽ، أخضر مصفر وأخضر مزرؽ، ويتـ الحصوؿ 

 لونيف متجاوريف أولي وثانوي.  عمييا مف مزج كميات متساوية مف

 *العلاقات المتبادلة بين الألوان:
تتفاعؿ الألواف مع بعضيا البعض في التصميـ، كما تتفاعؿ النغمات الموسيقية في المحف، ومف ىذا التفاعؿ تنتج علبقات 

سيادة أو التراجع أو الارتداد إلى العمؽ متبادلة بيف الألواف تتنوع ما بيف التكامؿ أو التوافؽ والانسجاـ أو التبايف، وما بيف ال
 وفيما يمي عرض لبعض العلبقات المتبادلة بيف الألواف ويمكف الاستفادة منيا كعناصر مؤثر في التصميـ: 

 أولًا: تكامل الألوان:
 الألواف المتكاممة ىي الألواف المتقابمة في الدائرة المونية.

لمكمؿ لأي لوف أساسي عبارة عف الموف الثانوي الناتج عف مزج المونيف لوف يكوف فييا الموف ا 12ففي دائرة الموف 
 الأساسيف الآخريف كالتالي: 

 أصفر + أزرؽ = أخضر )مكمؿ لموف أحمر(
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 أزرؽ + أحمر = بنفسجي )مكمؿ لموف الأصفر(
 أحمر + أصفر = برتقالي )مكمؿ لموف الأزرؽ(. 

 مة لبعضيا كالآتي:كما أف ىناؾ تكامؿ بيف الألواف الثلبثية المقاب
 الأخضر المزرؽ. مكمؿ  البرتقالي المحمر 
 البنفسجي المزرؽ.  مكمؿ  البرتقالي المصفر 
 البنفسجي المحمر .  مكمؿ  الأصفر المخضر 

  (47) وفي مجاؿ الملببس تستخدـ الألواف المتكاممة لتكويف تشكيمة ممبسية ناجحة ومتوافقة.

 ثانياً: تباين الألوان: 
ىرة التبايف الموني ىي التغير المرئي الذي يحدث في مظير الألواف عند تجاورىا دوف أي تأثير عمى تركيبيا المادي. ظا

  وىناؾ عدة أنواع لمتبايف الموني فيناؾ التبايف بيف الألواف المتكاممة )المتقابمة عمى الدائرة المونية(.
 الموناف المتكاملبف ليما نفس درجة التشبع والقيمة.ويحدث أقوي تبايف لوني للؤلواف المتكاممة إذا كاف 

ولا يتوقؼ التبايف عمى الألواف المتكاممة ولكف يمكف أف يحدث بيف الموف الواحد وقيمتو أي درجاتو الفاتحة والقاتمة، 
 منخفض التشبع(. ودرجات تشبعو )عالي التشبع،

ه( والألواف الباردة )كالأزرؽ، والبنفسجي المزرؽ، وغيره( عمى وىناؾ تبايف بيف الألواف الساخنة )كالأحمر، والأصفر، وغير 
 الدائرة المونية.  

 ثالثاً: توافق الألوان: 
التنسيؽ الدقيؽ لممجموعات المونية المستخدمة لمحصوؿ عمى مجموعة لونية تؤثر عمى العيف تأثيراً يتحقؽ التوافؽ الموني ب

 ساراً ممتعاً، وتتصؼ بالارتباط والوحدة بالرغـ مف الاختلبؼ الواضح بينيا أحياناً. 

 رابعاً: حرارة المون:
رودتو الواضحة أماـ العيف، والألواف الدافئة ىي تمؾ للؤلواف درجات حرارة مرئية مختمفة وحرارة الموف تعني دؼء الموف أو ب

المجموعة مف ألواف الطيؼ التي ليا أطواؿ موجية عالية التردد، ويمثؿ الموف الأحمر البرتقالي النياية العظمي لدؼء 
 الموف. 

رب ألوانيا لموف النار والشمس الأحمر والبرتقالي، والأصفر ويطمؽ عمييا الألواف الدافئة نظراً لتقا -وتشمؿ الألواف الدافئة: 
والدـ. وىي تعطي إحساس بالبيجة والدؼء والمرح والحيوية والنشاط، إلا أف المبالغة في استخداميا تؤدي إلى الإحساس 
بالعصبية. أما الألواف الباردة فيي تمؾ المجموعة مف ألواف الطيؼ ذات الأطواؿ الموجية قصيرة التردد، ويمثؿ الموناف 

 مخضر والأزرؽ النياية القصوى لبرودة الموف. الأزرؽ ال
والألواف الباردة تشمؿ: الأزرؽ والأخضر والأخضر المزرؽ والبنفسجي والبنفسجي المرزؽ وقد سميت بالألواف الباردة لأنيا 

بالغة في قريبة الشبة مف لوف السماء والبحار والمحيطات. وتؤدي للئحساس بالبرودة والراحة واليدوء، ولكف في حالة الم
 استخداميا قد يترتب عمييا الإحساس بالتعاسة. 

وتميؿ الألواف الدافئة لمتقدـ والسيادة فتعطي تأثيراً بالقرب أما الألواف البادرة فتميؿ لمتقمص والارتداد لمعمؽ فتعطي تأثيراً 
نظراً لطوؿ موجاتيا، كما يحدث  بالتباعد، ويرجع ذلؾ إلى أف عدسة العيف تتقمص ويزداد سمكيا عند رؤية الألواف الدافئة

عند رؤية الأجساـ القريبة، بينما يقؿ سمؾ العدسة عند رؤية الألواف الباردة ذات الموجات القصيرة كما يحدث عند رؤية 
 الأجساـ البعيدة، وىذا يفسر الشعور بتقدـ الألواف وارتدادىا.
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 خامساً: وزن المون: 
ىري، وىذا شعور يتولد في النفس نتيجة للئحساس بالثقؿ أو الخفة، والألواف الألواف ليس ليا وزف مادي بؿ ىو وزف ظا

التي توحي بالوزف أو الثقؿ ىي الألواف القاتمة والدافئة حيث تظير أكثر ثقلًب وكثافة، بينما تبدو الألواف الفاتحة والباردة 
 أخؼ في الوزف وأقؿ في الأىمية. 

وزف الموف أكدت أف الألواف القاتمة يجب أف توضع أسفؿ الألواف الفاتحة والتجارب التي أجريت في مجاؿ الإحساس ب
 لتحقيؽ الاتزاف فى التصميـ. 

 
 *عوامل مرتبطة وذات أثر عمى مظير الألوان: 

 الضوء:  :أولاً 
ط ونوع سقوط الأضواء الشديدة عمى سطح القماش يجعؿ الألواف تبدو أكثر تألقاً وبدرجات مختمفة تبعاً لشدة الضوء الساق

الموف وقدرتو عمى امتصاص أو عكس الضوء الساقط وكذلؾ درجة الموف، فالألواف الغامقة مف طبيعتيا أف تمتص الضوء 
الساقط عمييا، لذلؾ فيي تخفض مف الألواف التي تجاورىا، أما الألواف الفاتحة فيي تعكس الضوء فتوضح الألواف 

 المجاورة. 
ضاءة المعرض ليا، مف حيث كونيا طبيعية أو صناعية وقد ذكرنا ذلؾ بالتفصيؿ في وكذلؾ يتغير الموف ويتأثر بنوع الإ

)عنصر الضوء( فالإضاءة الطبيعية تختمؼ في درجات النيار المختمفة وبالتالي يختمؼ أثرىا عمى الألواف أما الإضاءة 
 مؼ تأثيرىا عمى الألواف. الصناعية فيختمؼ لونيا ويتنوع مثؿ الأصفر، والأبيض، والروز وغيره وبالتالي يخت

وبوجو عاـ فإف الضوء ذو الألواف الدافئة يقوي أو يرفع مف شدة الألواف الدافئة كالأحمر، والأصفر، والبرتقالي بينما 
"  للؤلواف الباردة كالأزرؽ والبنفسجي، وعمى العكس نجد أف الضوء ذو الألواف Grays"ويكسب درجة رمادية  يضعؼ

 شدة الألواف الباردة كالأزرؽ والبنفسجي وغيره ويضعؼ ويكسب درجة رمادية للؤلواف الدافئة. الباردة يقوي ويزيد 

 ثانياً: الخامة ومممسيا: 
إف نوعية الأقمشة ومممس سطحيا يؤثر عمى الألواف ومظيرىا وتألقيا، فباستخداـ نفس نوع الصبغة عمى أقمشة مختمفة 

اتيا، فالأقمشة اللبمعة كالستاف تعكس الضوء لذلؾ تبدو الألواف أكثر بريقاً المممس ينتج لنا مدي واسع مف الألواف ودرج
 . بينما الأقمشة المطفية كالجبرديف والكتاف والقطيفة والكتاف والصوؼ تمتص الضوء وتقمؿ مف شدة الألواف.   وشدة

 "Textureالمممس " -6
 * تعريفو:

سطح المواد أي الصفة المميزة لخصائص أسطح المواد، التي المممس ىو تعبير يدؿ عمى المظير الخارجي المميز لأ
تتشكؿ عف طريؽ المكونات الداخمية والخارجية وعف طريؽ ترتيب جزئياتو ونظـ إنشائيا في نسؽ يتضح مف خلبليا 

لعيف السمات العامة لمسطوح وما ينتج عنيا مف قيـ مممسية متنوعة. ويتـ التعرؼ عمى المممس لموىمة الأولي عف طريؽ ا
 المجردة ثـ نتحقؽ منو عف طريؽ المممس. 

 ملامس فعمية ممموسة:  -أ
وىي الملبمس التي يتـ اختبار سطحيا المادي والتعرؼ عمييا وتميزىا بحاسة الممس، فضلًب عف وضوح عناصرىا مف 

  (6/44) خلبؿ مظيرىا المرئي.
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 ملامس إيياميو:  -ب
ئي فقط لمساحات الخامات المستوية الثنائية الأبعاد، الخالية مف التجسيـ ترتكز في تأثيرىا الادراكي عمى المظير المر 

الممموس، حيث يمكف تمييز خصائصيا اعتماداً عمى السمات المونية والشكمية وتفسير ما تعكسو مف تأثيرات ضوئية تبعاً 
ث التركيز أو التكثيؼ أو الانتشار، لتوزيع المناطؽ المضيئة والفاتحة، والأخرى الظمية، والمظممة، ودرجات تفاوتيا مف حي

 ويُطمؽ أحياناً عمى ظاىرة إدراؾ الملبمس "المعادؿ البصري للئحساس الممسي". 

 "Pattern"  الزخارف -7
 . " في قاموس المورد تعني "رسـ، نموذج، نمط، شكؿ، نقش، تصميـ فنيPatternكممة "* التعريف: 

ومف الناحية  قة بنائية ناتجة عف تجمع أكثر مف مفردة أو عنصر تشكيمي." تعني "علبWebsterأما في القاموس ويبستر "
التصميمية يعني "تنظيـ الخطوط والفراغات والأشكاؿ والملبمس والألواف بالأساليب المتنوعة مف نسيج أو طباعة أو تطريز 

 أو أي إضافة زخرفية أخرى.
 اعتبارىا العامؿ الأكثر أىمية في أي تصميـ كما يمي:" بMotifيعتمد بشكؿ أساسي عمى الوحدة " وتصنيؼ الزخارؼ:

 
 

  
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 
 ":Source"أولا:تصنيف الزخارف تبعاً لممصدر

 ":Nature"الطبيعة  -1
ىي مصدر الإلياـ الأكثر آلفة وجمالًا فمعظـ عناصر الطبيعة تكوف ملبئمة للبستعماؿ في زخارؼ الأقمشة ، لكف أكثرىا 

ور حيث تكمف شعبيتيا وانتشارىا في تنوعيا اللبمتناىي وأشكاليا الممتعة وتناسؽ نسبيا وألوانيا وارتباطيا انتشاراً ىي الزى
في الذاكرة بالبيجة والرضا النفسي والانشراح والسعادة ومف مظاىر الطبيعة المستخدمة أيضاً أوراؽ الشجر، والنباتات، 

تصنيف الزخارف 
 تبعاً الى

 

 المصدر

 طريقة التفسير والترجمة 

 

 طريقة الترتيب 

 

 عناصر طبيعية طبيعية
أشياء مصنوعة 

 الخياؿ مصنوعة مصنوعة
 

 الرموز

 واقعية 
 ؤسمبة()م محورة اصطلبحية

 تجريدية 
 ىندسية  

 في جميع الاتجاهات

 في أربع اتجاهات

 في اتجاهين

 في اتجاه واحد  
 الكنار

 في ترتيب متباعد 
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، والأمواج، والأصداؼ، والقواقع، والأشجار، وتجزيعات الخشب ، والجباؿ والفاكية والحيوانات، والطيور، والأسماؾ، والبحر
 وغيرىـ. 

 ":Man Made"الأشياء المصنوعة  -2
وىي كؿ الأشياء التي صنعيا الإنساف إما لأغراض نفعية أو جمالية مثؿ أبريؽ الشاي، الأواني، والأوعية، والأثاث، 

الموسيقية، والساعات، وقوالب الطوب، والمفاتيح، والميداليات، والماكينات،  وأدوات المعب ، والمباني، والخرائط، والآلات
والآلات وغيرىا وأشكاؿ الوحدات ليا استعمالاتيا الخاصة وأماكنيا المحددة أو المناسبات التي تستخدـ فييا فتوحي بتداعي 

نلبحظ ضيؽ حدود الفرص التي تستطيع  سار لممعاني وعندئذ قد تكوف أكثر ملبئمة مف أشكاؿ الوحدات الطبيعية، وىكذا
 أف تكوف فييا ملبئمة. 

 " :Imaginationالخيال " -3
قد ينطمؽ الخياؿ عند الإبداع بعيداً عف المصادر الطبيعية أو المصنوعة مستشعراً حسا معيناً أو نكية معينة أو صوتاً 

وجودة في أي شيء. فمثلًب الأشكاؿ اليندسية معيناً ، فيترجـ ما يستشعره ترجمة حسية في خطوط أو أشكاؿ لا تكوف م
 التامة نادراً ما تتواجد في الطبيعة واضحة لمعيف المجردة لكنيا غالباً ما تري كمنتجات للئبداع الإنساني. 

 ":Symbolismالرموز " -4
قدـ شيء ما لا ىي طراز خاص مف الخيالات ، تتعمد أف تبدي لمعياف إبداعات تعني شيء مختمؼ تماماً، ففي الغالب ن

 يكوف مرئي ولكنو رمز لشيء معيف مثؿ فكرة ، حركة سياسية، دينية ، منظمات، شركات تجارية. 
فالرمز باختصار "طريقة تعريؼ مرئية مختصرة في حيز صغير لشيء لا يمكف رؤيتو إلا بيذه الطريقة". والرموز تداولت 

وز نجدىا ذات قوة وسطوة في ثقافة ما تصبح مجرد زخرفة عبر العصور، رموز اكتسبت قيمة، ورموز فقدت معناىا، رم
في ثقافة أخرى، وما يمثؿ مجرد زخرفة ذات مرة، قد يصبح رمز لو قوة، ثـ يعود ويتحوؿ مرة أخرى إلى زخرفة. مثاؿ لذلؾ 

معني روحي " نجده غالباً في معظـ الثقافات القديمة تنوعت رمزيتو ، لكف لو دائماً The Swastikaالصميب المعقوؼ "
يجابي إلا أنو استبعد الآف بسبب ارتباطو بالنازية. وىكذا نجد أف حياتنا لا تخمو مف الرموز فيناؾ حروؼ تبدو  وا 

 كأصوات، وكممات تبدو كأفكار، ورموز كيميائية تبدو كعناصر فيزيائية ، ورموز إحصائية تبدو كإجراءات ونتائج . 
عية أو مف الأشياء المصنوعة كما نجد في انتخابات مجمس الشعب فبعض ومف الممكف أف تُستميـ الرموز مف الطبي

المرشحيف يختاروف حيواناً أو الشمس أوالقمر أو الأشياء المصنوعة مثؿ الفانوس أو السمـ أو الكرسي كرمز ليـ. وقد 
و الييئات حتى أف تكتسب الرموز احتراـ الآخريف مثؿ الرموز الدينية والسياسية والتجارية ورموز بعض الشركات أ

 استخداميا بشكؿ زخرفي مف قبؿ الآخريف يكوف غير شرعي . 
 

 ":Interpretation "ثانياً: تصنيف الزخارف طبقاً لطريقة تفسيرىا
إف الوحدات المستمدة مف مصادر مختمفة لابد وأف تقدـ بطريقة ما، فالعنصر الواحد ممكف أف يقدـ بأكثر مف طريقة فقد 

 ية أو اصطلبحية، أو تجريدية، أو ىندسية كما يمي: يقدـ بطريقة واقع

 ":Realistic interpretation"التفسير الواقعي  -1
يتناوؿ الأشياء الطبيعية والمصنوعة التي تظير فقط في الواقع وليس في الخياؿ. وفي النظرة الواقعية تظير الزخارؼ كما 

انيا مشرقة كما في الواقع مظممة، متداخمو، توحي بالعمؽ والمنظور لو كانت صورة فوتوغرافية ممونة لمشيء، وبالتالي فألو 
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أي سوؼ تكوف محاولة لنسخ الواقع باستخداـ الرسـ المنظوري والتظميؿ وتداخؿ الأشياء والمممس الخ وبالتالي لف يكوف 
 نفسجية .ىناؾ خطوط سوداء تحدد الحواؼ، ولا يكوف ىناؾ أوراؽ شجر زرقاء أو أبقار أرجوانية أو حبوب ب

 ":Stylized interpretation"التفسير المحور )المؤسمب(  -2
 الأسمبة ىي تحريؼ للؤشكاؿ الطبيعية أو الأشياء المصنوعة بشكؿ خيالي أو تصوري وليست تقميداً 

 حيث يستطيع المصمـ أف يبتكر بحرية فيغير الألواف ويبسط التفاصيؿ ويسطح المنظور بحيث تبقي الأشياء مدركة سيؿ
 التعرؼ عمييا .  

 ": Abstract Interpretation"التفسير التجريدي  -3
ىو تفسير غير تمثيمى، ولا يصور أي أشياء مدركة أو متعارؼ عمييا، سواء كانت طبيعية أو مصنوعة يطمؽ خياؿ 

ي ، وكذلؾ ما الإنساف كأشكاؿ حرة غير محددة حيث يمكف ادراج الرش بالموف أو طباعة السداء ضمف التفسير التجريد
 نجده في أعماؿ الفنانيف موندرياف أو بولوؾ. 

 
 ":Geometric Interpretation"التفسير اليندسي -4

أي الزخارؼ اليندسية ونجدىا في النسيج الشعبي اليدوي وأيضاً في العمارة اليندسية مف أشكاؿ ىندسية معقدة ومتشابكة 
 مف مستطيلبت، ومثمثات، وأشكاؿ سداسية وغيرىا. 

" وقماش البولكا المنقط Plaids" والمربعات كرقعة الشطرنج "Checkونجدىا في الأقمشة في المقممات والكاروه "
"Polka . 51/143" وغيرىا مف الأشكاؿ اليندسية)  

يا والزخارؼ اليندسية يمكف رؤيتيا أيضاً كنوع مف التجريد لأنيا تعد سلبلة مف التخيلبت وتمثيؿ لأشياء غير متعارؼ عمي
 ولا توحي بأشياء محددة .

 
 "  كتروني بجامعة الاماـلالا المرئى لعرضيا عمى منظومة التعمـ تييئة المادة العممية لعناصر تصميـ الاعلبف ثانيا :

 مفيوم التعميم الإلكترونى : 
ى الى الطلبب خارج ىو عبارة عف استخداـ الوسائط الإلكترونية مف قبؿ مؤسسات التعميـ الجامعى لنقؿ المحتوى التعميم

 الحرـ الجامعى او داخمو .

 نظم التعميم الالكترونى : 
 وينقسم الى نوعين :

(  وىو عبارة عف نظاـ صمـ لممساعدة فى ادارة ومتابعة وتقيـ التعميـ والتدريب    LMS)   نظام ادارة التعميم الالكترونى -
 –التوصيؿ  –دمات التى يقوـ بيا ىذا البرنامج ) التسجيؿ وجميع انشطة التعمـ فى المنشات عبر الانترنت .ومف اىـ الخ

 الاتصاؿ الاختبارات (  –التوصيؿ  –التفاعؿ  –التتبع  –الجدولة 
(  وىو حزـ برامج متكاممة لتكويف نظاـ لإدارة المحتوى المعرفى المطموب تعممو    LCMS)   نظام ادارة محتوى التعمم -

كـ فى عممية التعمـ ، ومف اىـ مزياه القدرة عمى انشاء محتوى جديد ، وتطوير او التدريب عميو ،وتوفر أدوات لمتح
 المحتوى الحالى وادارتو  .
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 Aوبرنامج أ تيوتر )  –برنامج دوكيز  - (  Moodleومف أمثمة بعض برامج التعميـ الإلكترونى ) برنامج مودؿ  ) 
Tutor   )-  (  ونظاـ ويب سى تىWeb CT   )- نظاـ البلبؾ ب ( وردBlackboard  )–  نظاـ مجد لادارة الفصؿ

 نظاـ تدارس لادارة التعميـ الالكترونى  (  –الالكترونى 
 نظام إدارة التعمم تدارس : 

ىو أحد أنظمة إدارة التعميـ تـ تصميمو عمى أسس تعميمو ليساعد أستاذ المقرر عمى توفير بيئة تعميمية الكترونية ويوفر 
 موقع خاص بو بكؿ يسر وسيولة لإدارة المقرر .إمكانية إنشاء وتصميـ 

 مكونات نظام إدارة التعمم تدارس : 
الصفحة الرئيسية تدارس وىى عبارة عف بوابة معمومات لممقرر تتكوف مف قوالب مثؿ ) التقويـ والدخوؿ والخبار ويمكف 

التى تـ انشاؤىا وىى موجودة ومرتبة فى  تشكيميا وتغيرىا حسب الرغبة ( ، والجزء الأوسط مف الشاشة مف قائمة المقررات
مجموعات ، وىناؾ وظائؼ إدارية مثؿ تسجيؿ الطلبب والواجبات ووضع الدرجات والاختبارات ، ونظاـ التقارير  والمكتبة 

 الرقمية والمنتديات والدروس التفاعمية .
 

 Macromedia"  أحد البرامج الأساسية فى تصميم الموقع الأكترونىتتم ىذه العممية من خلال 
Dreamweaver MX : 

غنية بالأدوات التي يسيؿ الوصوؿ إلييا، والموحات  برنامج سيؿ الاستخداـ وواجيتو  Dream weaver MX برنامج 
ولكى نتعرؼ عمى ىذا البرنامج لا بد مف نظرة   الويب،أفضؿ أدوات تحرير صفحات  التي تعطيؾ تحكما أكبر، وىو مف

البرنامج  العمؿ، التعرؼ عمى استخداـ بعض الأدوات الميمة، تجد ىنا صورة لواجية وساحةسريعة عمى شاشة البدء 
   Mac .(1) )   لمستخدمي ويندوز )لف تختمؼ الواجية كثيرا عند مستخدمي 

 

 Dreamweaver MX شكل يوضح الشاشة الرئيسية لبرنامج
 (1) Macromedia Stodio MX : "  exploring Macromedia Studio MX " .Index 

 (1)عمل صفحة وحفظيا     
 إف الموقع يتكوف مف عدة صفحات مترابطة، ويوضح البحث كيفية عمؿ صفحة جديدة في دريـ ويفر وحفظيا.



 العدد العاشر                                                                           ة العمارة والفنوف           مجم

  223 

 .File>  New. مػػػػػػػػػػػػػػػػػػػػف القائمػػػػػػػػػػػػػػػػػػػػة فػػػػػػػػػػػػػػػػػػػػي أعمػػػػػػػػػػػػػػػػػػػػى البرنػػػػػػػػػػػػػػػػػػػػامج اختػػػػػػػػػػػػػػػػػػػػر 1
 لاحظ الصورة: HTMLاختر  New Documentومف النافذة 

 
يار. اضغط ضغطا مزدوجا عمى الخ2  

HTML أو اضغط ،Create. 
 يظير ما كتبت كالتالي: حيث ،جزء مف مادة عناصر التصميـ. في الصفحة التي ستفتح عندؾ أكتب 3

 
 Imageمف عمى لوحة المفاتيح لعمؿ سطر جديد، ومف شريط الإدراج اضغط عمى  Enter. بعد ىذا النص اضغط 4

 .Imageلبرنامج واختر في أعمى ا Insertلإدراج صورة أو اذىب إلى قائمة 
 مثلب( واختر الصورة  My Picturesومف النافذة التي ستظير لؾ أدخؿ إلى أي مجمد بو صور )

 .OKالتي تعجبؾ 
 مف الخيارات التي Commonبدلا مف  Text. ظمؿ السطر الأوؿ، ومف شريط الإدراج اختر 5
 لخط.، سيتغير حجـ اH2لديؾ ومف الأزرار التي تظير لديؾ اضغط عمى  
 Size، والحجـ Tahomaإلى إلى  Font. أيضا ظمؿ السطر الثاني، ومف لوحة الخصائص بالأسفؿ غير نوع الخط 6

 .points 10إلى 
)سنستخدمو بعد   my webداخؿ مجمد باسـ  index.htm، باسـ File>Save. احفظ الصفحة التي قمت بعمميا: 7

 ذلؾ(.
 . أغمؽ الصفحة، ولا تغمؽ البرنامج. 8
 .my webمف المجمد  File>open>index.htmافتح الصفحة  .9

مف شريط الأدوات، واختر البرنامج الذي تريد  Preview. ولتستعرض صفحتؾ في المستعرض اضغط عمى الزر 10
 (. Internet Explore الإستعراض فيو )لدي

 

http://www.m3loma4u.com/pafiledb3.1/pafiledb.php?action=category&id=10)1( 

، ولإظيار ىذا الشريط إذىب Standardتستطيع عمؿ صفحة جديدة وحفظيا وفتح الصفحات مف خلبؿ الشريط  ملاحظة:
 . Standard يميف ونختارClick  . أو View>Toolbars>Standardإلى: 

 -التعامل مع الجداول: 
 في الصور،  إف الجداوؿ ىي مف أىـ الأدوات التي يستخدميا مصممو المواقع، فلب تجد موقعا رتبت

 والنصوص والخمفيات وغيرىا مف الوسائط دوف استخداـ الجداوؿ.

http://www.m3loma4u.com/pafiledb3.1/pafiledb.php?action=category&id=10(1)
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 ا عبارة عف مجموعة مف الصفوؼ الأفقية والأعمدة، التي تستطيع دمجيا أو فصميا وترتيبي إف الجدوؿ
 (1)فى برنامج دريـ ويفر. 

  جدوؿ جديد عمؿ .1
 (Ctrl+Alt+T )أو مف لوحة المفاتيح نختار:التالية مف قائمة الإدراج اضغط عمى زر الجدوؿ و حدد القيـ كما في الصورة

 
 
 خلبيا جديدة لتعديؿ ىذا الجدوؿ سواء بدمج إحدى خلبيا ىذا الجدوؿ مع الأخرى أو في إنشاء -2

 :المنسدلة لبيا في الجدوؿ وبزر الفأرة الأيمف اختر مف القائمةحدد أوؿ ثلبث خ
Table>Mergecell 

   Table>Splitcell الثاني لتقسيـ خمية نختار أوؿ خمية مف اليميف مف الصؼ
 ok اترؾ القيـ كما ىي و اضغط 

الجدوؿ  سيتحدد لأيسرالجدوؿ سيتغير شكؿ مؤشر الفأرة، الآف اضغط ضغطة واحدة بزر الفأرة ا عمى أحد خطوط  -3
 .بخط أسود

  :غير القيـ حسب الصورة التالية properties مف لوحة الخصائص

 

بشكؿ عادي كما تعممنا سابقا و كذلؾ  لمكتابة داخؿ الجدوؿ نضغط بمؤشر الفأرة في أي خمية نريد الكتابة فييا ونكتب -4
 .الحاؿ عند إدراج الصور

(1) Macromedia Stodio MX : "  exploring Macromedia Studio MX " .Index 

 :Templates لقوالب
 :جديد إتبع الآتي template لعمؿ قالب

File>New 
  HTML ومنو Template و مف النافذة اختر
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 Editable Region لعمؿ -
Insert>Template objects>Editable region  

 )1احفظ القالب بأي أسـ )مثلب 
 بالتالي ة قـلإدراج قالب إلى صفح  -

Modify>Template>Apply template to page 
 أكتب أي نص بداخمو وأدرج أي صورة ثـ  نغمؽ الممؼ.Editable region ومف الػ -
 افتحو لتعديؿ القالب -

File>Open 
 .ومف النافذة اختر القالب الذي قمت بحفظو

 (1) .بحفظوشئت )مثلب ضع في الأسفؿ الحقوؽ والسنة( ومف ثـ قـ  غير فيو ما

  :الروابط التشعبية

الموقع إلى صفحة  الروابط التشعبية ىي بشكؿ مختصر وسيمة لمتنقؿ مف صفحة في الموقع إلى أخرى، أو مف صفحة في
الواحدة، وغالبا ما تكوف عبارة عف نص يختمؼ عف  أخرى في موقع آخر، أو حتى التنقؿ إلى أماكف مختمفة في الصفحة

عندما يمر عميو، أو عبارة عف صورة يتغير شكؿ مؤشر الفأرة عندما يمر عمييا،  كؿ مؤشر الفأرةالنص العادي ويتغير ش
 .وىناؾ طرؽ مختمفة لعمؿ الروابط، وغايات مختمفة أيضا ىذا عادة

 .ثلبث كممات في صفحة جديدة، كؿ كممة في سطر في البداية قـ بكتابة  -1
 :مربع نص لكتابة الرابط فيو، لاحظ الصورة في ستجد اختر أوؿ كممة ومف لوحة الخصائص  -2

 

 .أكتب فيو عنواف الصفحة المراد الانتقاؿ إلييا
 .صورة المجمد لفتح نافذة، ومنيا اختر الصفحة المراد الانتقاؿ إلييا أو بالضغط عمى -3
 .وىي عبارة عف مؤشر point-to-file ىنا أداة تسمى  -4

لمنص المراد عمؿ رابط لو اضغط عمى ىذا المؤشر، وقـ بسحبو مع استمرار تحديدؾ  طريقة عمؿ ىذا المؤشر ىي بعد
 . إلى أي صفحة في لوحة الممفات عمى اليميف الضغط

 

 اضغط بيميف الفأرة عمى الكممة ومف القائمة المنسدلة اختر ذاؾ بالنسبة لمكممة الأولى أما بالنسبة لمثانية فبعد تحديدؾ ليا -5
Make linkمنيا اختر الصفحة المراد الانتقاؿ إلييا ة، ستظير لؾ نافذ. 

، أو Link واكتب الرابط في مربع النص  زر الربط مف شريط الإدراج الآف حدد الكممة الثالثة واضغط عمى -6
 .الأصفر إضغط عمى المجمد
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 . ينطبؽ ما ذكر في النقطة السابقة عمى الربط لمبريد الإلكتروني  -7
 Text مربع النص  لسابقتيف دوف تحديد نص وذلؾ بتحديد النص فيويمكنؾ عمؿ النقطتيف ا  -8
 ( .4، 3، 2أخيرا لعمؿ روابط لمصور استخدـ الطرؽ في النقط  )  -9

 :رفع الموقع

التي أوضحتاىا سابقا،  مف جاىزية الموقع لنشره عمى الإنترنت، يتـ توضيح طريقة الاتصاؿ بالخادـ بالطرؽ بعد التأكد
 :التالية ، لاحظ الصورةFTP ىي عف طريؽ بروتوكوؿوالطريقة الأشير 

 

 
 

  .مساحة لديو طبعا ىذه المعمومات يعطيؾ إياىا مزود خدمة الاستضافة والذي قمت بحجز

 
، بعد نجاح الإتصاؿ  لعمؿ اتصاؿ في البداية نحتاج لعمؿ اتصاؿ مف لوحة الممفات اضغط عمى ىذا الزر  -1

 . سيبدو بيذا الشكؿ
 والذي يعني Put بأكممو، اضغط عمى الزر ذو السيـ الأزرؽ لممفات اختر الممفات المراد رفعيا أو المجمدلرفع ا -2

Uploadأنؾ في الػ بعد التأكد مف ، وذلؾLocal view.   
 الذي يعني Get المجمد بأكممو، اضغط عمى الزر ذو السيـ الأخضر لتنزيؿ الممفات، اختر الممفات المراد تنزيميا أو  -3

Downloadالتأكد مف أنؾ في الػ بعد ، وذلؾRemote view. 
  ، سيتغير شكمو إلى الوضع العادي لقطع الإتصاؿ إضغط عمى زر الإتصاؿ   -4

 :أما الطريقة الأخرى فيي FTP ىذا بالنسبة لطريقة
Local/Network إذا كنت تستخدـ مجمد في شبكة أو عمى سيرفر في جيازؾ.  
 Put ) .    ثـ b " الخيار"عمى الجياز أو الشبكة )قمنا بيذه الخطوة في الدرس الثالث  لسيرفرببساطة نحدد مجمد ا

 

 نتائج البحث
استخداـ تطبيقات الإنترنت والانترانت فى العممية التعميمية ، حيث يتـ الاستفادة لمطلبب مف اوضحت الدراسة اىمية  -

نى ) تدارس ( لمتعميـ الالكترونى فى جامعة الاماـ محمد ف سعود تطبيؽ مقرر تصميـ الاعلبف المرئى عمى منظومة عمم
 الاسلبمية .
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يحقؽ مقرر عناصر تصميـ الإعلبف المرئي تفعيؿ التعميـ الالكترونى تظاـ تدارس  فى كمية الإعلبـ والإتصاؿ، عمى  -
ـ الالكترونى فى كميات الاعلبـ ، و يمثؿ مرحمة ىامة فى ادخاؿ نظاـ التعميفى العممية التعميمية إضافة كمية ونوعية

 والاتصاؿ .

 التوصيات

ضرورة إدخاؿ تعديلبت وتجديدات جذرية في نظـ التعميـ ، بحيث يصبح التعميـ المستمر مدى الحياة أحد المجالات  -
، الجامعة  الرئيسية للبىتماـ والرعاية ، ومف ثـ الاىتماـ والتوسع في صيغ متنوعة لمتعميـ العالي مثؿ : الجامعة المفتوحة

بلب أسوار ، وكميات المجتمع، والكميات التكنولوجية ، والجامعات الحرة ، وغيرىا أنماط جديدة وواضافات لمتعميـ العالي 
غير ما ىو دارج ومألوؼ مف مؤسسات تقميدية، مما ينعكس عمى عممية التصميـ الابتكارى فى مجاؿ الاعلبـ  وربطيا 

 الدائـ بالمصمميف مدى الحياة .
ضرورة التعاوف العربى العربى ،والعربى العالمى فى تفعيؿ التعميـ الالكترونى فى التعميـ الجامعى، بما يعود بالتقدـ فى  -

 مجاؿ الاعلبـ والاتصاؿ  .
، وتمكينيـ مف التعميـ الالكترونى للبستفادة القصوى مف تقنية الأساتذةوضع برامج لتدريب طلبب كمية الإعمـ والإتصاؿ و  -

 لبحث والدراسة التفاعمية ، عف طريؽ تكنولوجيا المعمومات المتاحة عمى الإنترنت والانترانت والاكسترانت  .إتقاف ا
التعميـ الالكترونى ، والعروج الاىتماـ بالمكتبات المتخصصة ودعميا وتزويدىا بأحدث التقنيات المستخدمة في مجاؿ  -

 الى الابحاث المتخصصة فى ابحاث التعميـ الجوالى  .
معا في شبكة لممعمومات ، مما يزود مخططي سياسات التعميـ ومتخذي القرار ، والمسئوليف  التعميميةربط المؤسسات  -

دارتيا.  التنفيذييف والأساتذة الباحثيف بالمعمومات اللبزمة لإنجاح أعماليـ وا 
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